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Trademarks 

Microsoft is a U.S. registered trademark of Microsoft 
Corporation. 
Windows, Windows Vista, Windows 7 and Windows 8 are either 
registered trademarks or trademarks of Microsoft Corporation in 
the United States and/or other countries. 

IBM, IBM PC are registered trademarks of International Business 
Machines Corp. 
Other brands and product names herein are trademarks or 
registered trademarks of their respective holders. 

Copyright 

All rights reserved. No part of this publication may be 
reproduced, transmitted, transcribed, stored in a retrieval 
system, or translated into any language or computer language, 
in any form or by any means, electronic, mechanical, magnetic, 
optical, chemical, manual, or otherwise, without the prior 
written permission of Avision Inc. 
 
Material scanned by this product may be protected by 
governmental laws and other regulations, such as copyright 
laws, the customer is solely responsible for complying with all 
such laws and regulations. 

 

Warranty 

The information contained in this document is subject to 
change without notice. 
 
Avision makes no warranty of any kind with regard to this 
material, including, but not limited to, the implied warranties 
of fitness for a particular purpose. 
 
Avision shall not be liable for errors contained herein or for 
incidental or consequential damages in connection with the 
furnishing, performance, or use of this material.  
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Federal Communications Commission (FCC) compliance 
information statement 
Part 15 
 
The product has been tested and found to comply with the 
limits for a Class A digital device pursuant to Part 15 of the FCC 
Rules.  Operation is subject to the following two conditions: (1) 
this device may not cause harmful interference and (2) this 
device must accept any interference received including 
interference that may cause undesired operation. 
 
The FCC Class A limits are designed to provide reasonable 
protection against harmful interference when the equipment is 
operated in a commercial environment.  This equipment 
generates, uses, and can radiate radio frequency energy and, if 
not installed and used in accordance with the instruction 
manual may cause harmful interference in which case the user 
will be required to correct the interference at his own expense. 
 

 
 

European Union Regulatory Notice 

Products bearing the CE marking comply with the following EU 
Directives: 

 Low Voltage Directive 2006/95/EC 

 EMC Directive 2004/108/EC 
 

CE compliance of this product is valid if powered with the correct 
CE-marked AC adapter provide by Avision. 

This product satisfies the Class A limits of EN55022, EN55024 
and safety requirements of EN 60950. 
 

*This machine is certified as Class 1 LED product. This means 
that this machine does not produce hazardous laser radiation. 
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CE Warning 

This is a class A product. In a domestic environment this 
product may cause radio interference in which case the user 
may be required to take adequate measures. 
 

Disposal of Waste Equipment by Users in Private Union 

 

This symbol on the product or on its packaging indicates that 
the product can not be disposed of with your other household 
waste.  Instead it should be sent to appropriate facilities for 
recovery and recycling in an effort to protect human health and 
the environment.  Fore more information about where you can 
drop off your waste equipment for recycling, please contact 
your local city office, your household waste disposal service or 
the shop where you purchased the product.   
 

 

As an ENERGY STAR® Partner, Avision Inc. has 
determined that this product meets the ENERGY 
STAR guidelines for energy efficiency. 

 

System Requirements 
 IBM compatible PC 586, Pentium or higher 
 Microsoft Windows XP(SP3), Windows Vista/Windows 

7/Windows 8 
 USB port 2.0 (compatible with USB 1.1) 
 At least 100 MB of free hard disk space (500 MB is 

recommended) 
 At least 128 MB of system memory (512 MB of RAM is 

recommended)  
At least 1 GB of RAM for Windows Vista or later 

 A CD-ROM drive 
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1. Introduction 

 
 
 
Congratulations on your purchase of the Avision’s bookedge 
scanner.  Avision is one of the leading companies to make 
high quality color image scanner. 
 
Before you install and operate the new scanner, please take 
a few minutes to read through this manual.  It provides 
proper instructions for you to unpack, install, operate and 
maintain the scanner. 
 
The following figure indicates the package contents.  Please 
check all the items against your checklist.  If you do not 
receive all the items, please contact your authorized local 
dealer immediately. 

  

  

1 
2 

3 
4 

1. Scanner Main Unit 
2. Software CD/Quick Guide 
3. USB Cable 
4. Power Adapter & Power Cord 
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Note:  
1. Only use the AC adapter DA-48M24 by APD included in the 

machine.  Using other AC adapters may damage the 
machine and void the warranty. 

2. Please unpack the packing carefully, and check the contents 
against the checklist.  If any items are missing or damaged, 
please contact your dealer immediately. 
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2. Scanner Installation 

 
 
 

Precautions 

 
 Keep the scanner out of direct sunlight.  Direct 

exposure to the sun or excessive heat may cause 
damage to the unit. 

 Do not install the scanner in a humid or dusty place. 

 Be sure to use the proper AC power source. 

 Place the scanner securely on an even, flat surface.  
Tilted or uneven surfaces may cause mechanical or 
paper-feeding problems. 

 Retain the scanner box and packing materials for 
shipping purposes. 
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2.1 Unlocking your scanner 

To protect the scanning unit from damage during 
transportation, a lock switch is designed at the back of the 
scanner to keep the scanning unit from moving. To unlock the 
scanner, move the lock switch down as shown in Fig. 2-1.  

 

 
 

Figure 2-1  Unlocking the Scanner 
 

 
 

 Figure 2-2  Home position 
 
Note: If the scanning unit is not located at the front of the 
scanner before transporting the scanner, be sure to do the 
follows: 
1. Turn on the scanner. The scanning unit should move to 

the front of the scanner. 
2. Press the lock switch down to the “Lock position”. 
3. The scanner is now ready to transport. 

Scanning unit at 
this position 
before locking the 
scanner 
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2.2 Installing the Scanner Driver and Connecting the 
Cables 

NOTE:  
1). The Windows system CD may be required when installing 

on some PC’s. 
2). To ensure your computer can identify the USB scanner, 

please install scanner driver first before connecting the 
scanner to your computer. 

3). The scanner driver contains TWAIN, ISIS and WIA driver.  
If you are running Windows Me, Windows XP, or Windows 
Vista, after the installation of scanner driver is completed, 
this scanner allows you to scan via a TWAIN, ISIS, or a 
WIA interface.  Start your TWAIN-compliant image editing 
software application to select a TWAIN or WIA user 
interface or your ISIS software to select an ISIS user 
interface.  You may also launch Microsoft’s Scanner and 
Camera Wizard to scan via a WIA user interface. 

 

2.2.1 Connecting to Power 

Before connecting, make sure the power switch is off. 

Plug the small end of the power adaptor into the power jack of 
your scanner.  Insert the other end to an appropriate power 
outlet. 

 

  
 

Figure 2-3 
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2.2.2 Turning on the Power 

Press the Power Switch button on the front panel, the Power 
LED will be lit.  To turn off the scanner, press the Power 
Switch button for about 3 seconds, the Power LED will be off. 
 

      
 

Figure 2-4 

 

2.2.3 Installing the Scanner Driver 

1. Place the supplied CD-ROM onto your CD-ROM drive. 

2. The software installation graphic appears.  If not, run 
“setup.exe”. 
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Contents on the installation graphic: 

 Install Button Manager V2:  To use the buttons 
on the scanner, you need to install Button Manager 
V2.  To ensure Button Manager V2 works properly, 
please FIRST install Button Manager V2 before 
installing the scanner driver. 

 Install Scanner Driver:  To communicate with 
your scanner, you need to install the scanner driver.  
After installing the Button Manager V2 software, 
click Install Scanner Driver to install the scanner 
driver on your computer. 

 Install Adobe Reader:  To view the user’s 
manuals for the scanner and Button Manager V2, 
you need to use Adobe Reader to open and view the 
manuals in pdf file format.  If you already have 
Adobe Reader installed on your computer, you may 
disregard this item. 

 View Manual:  Click “View Manual” to view or 
print the detailed user manual for the scanner and 
Button Manager V2 respectively. 

3. Click Install Button Manager V2 to install the Button 
Manager V2 software and then click Install Scanner 
Driver to install the scanner driver on your computer. 
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2.2.4 Connecting to Computer 

1. Connect the square end of the USB cable to the USB port of 
your scanner. Connect the rectangle end to the USB port of 
your computer. 

 

  
 

Figure 2-5 
 

2. The computer should detect a new USB device and prompt 
a “New Hardware Found” message. 

3. In Windows XP, click the Next button to continue. When 
the XP certification screen appears, click Continue 
Anyway to complete the installation. 

4. When the Finish dialog is prompted, click the Finish 
button.  
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3. Completing Your First 
Scan 

 
 
 

3.1 Loading Your Paper 

Open the document cover ,and then place your original face 
down on the document glass as shown in Fig. 3-1.  
 
Make sure the top of your original near the document 
alignment mark. 
 

 

1 

2 
3 

4 

 
1. Document cover 
2. Document alignment mark 
3. Your original 
4. Document glass 

 
Figure 3-1 Placing the original 
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3.2 Verifying Your Scanner Installation 

To verify if your scanner installation is correct, Avision provides 
you a useful test program called Avision Capture Tool.  With 
this tool, you can perform simple scans and view the captured 
images.  In addition, it helps you complete your scan at a rated 
speed. 
 
The following procedure describes how to verify your scanner 
installation.  If the installation is not correct, please review the 
preceding section to check if the cable connection and scanner 
driver have been successfully installed.    
 
Before you begin, be sure the scanner is on. 
 
1. Select Start>Programs>Avision AVxxx Scanner>Avision 

Capture Tool. 

Note:  If Avision Capture Tool does not appear on “All 
Programs” of your Start menu, please access from the 
following path:  
C\Windows\TWAIN_32\Avision\Avxxx\Avision Capture 
Tool.exe 

The Select Scanner Model dialog box will be displayed.  
 

 
 

2. Select your driver type and scanner model and click OK.  
The following Avision Capture Tool dialog box will be 
displayed. 
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Setup    

Actual  
Size

Fit 
Page 

Scan 
File Format 

Save       File Path 

 

3. Choose your desired file format from the File Format drop 
down list box. (Default is BMP, other choice includes TIFF, 
MTIFF, PDF, MPDF, GIF, and JPEG.) The supported file 
formats vary depending on your scanner model. 

4. Type your desired folder name and file name in the File 
Path box. (Default is C:\My Scan\Image.) 

Note:  
If you do not wish to save the scanned image, deselect the 
Save button since default is Save Enable. In this case, the 
thumbnail view will be disabled.  And therefore, after 
viewing all the scanned images, only the last one will 
remain on the screen.   

5. Click the Setup button ( ) or choose Setup from the 
File menu to prompt the Scanner Properties dialog box. 
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Image 
Selection 

Box 

 
6. From the Image Selection Box, choose your desired image 

type for your scanned image.  (Default is Front B&W)  If 
you have a duplex scanner, choose Front and Rear to scan 
both sides of your document.  

7. Click OK to quit the Scanner Properties dialog box.  (To 
learn more details about the Scanner Properties dialog box, 
please see the subsequent chapter, Using the Scanner 
Properties Dialog Box.) 

8. Place your document face down on the document glass or 
face up in the auto document feeder. 

9. In the Scan Validation dialog box, click the Scan button 

( ) or choose Scan from the File menu. 

10. The document will be scanned and displayed in the Scan 
Validation screen.  After the scanned images have been 
displayed, your scanner installation verification is 
completed.  
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 Thumbnail View Status Bar Fit Page View 
 

11. You can view the scanned image in Fit Page ( ) or 

Actual Size (100%) button ( ) from the Viewing toolbars 
at the right side. 

12. Click the Close box or Quit from the File menu to exit the 
Scan Validation Tool. 
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3.3 A Glance of the Scanner Properties Dialog Box 

 

 

3 
4 
5 
6 
 
7 

1 

 

2 

8 

 
1. Tab Options Choice:  Image, Compression, Color Dropout, 

Paper, Multi-Feed Detection, Preview, Options, 
Settings, Information. 

2. Image 
Selection Box  

Choose your image type and the side of 
document you wish to scan.  Options vary 
based on type of scanner.  

3. Brightness Adjust the brightness level from –100 to +100.   
4. Contrast Adjust the contrast level from –100 to +100. 
5. Resolution Determine the quality of the scanned image.  

The industry standard is 200 dpi. 
6. Invert Reverse the color of your scanned image. 
7. Scan Source  Choice: Auto Document Feeder, Flatbed, 

Flatbed (Book), Automatic (varies due to 
different scanner model)  

8. Defaults Reset all values on the tabs to the factory 
default settings. 
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4. Using the Scanner 
Properties Dialog Box  

 
 
The Scanner Properties dialog box allows you to configure the 
scanner’s settings. It consists of several tabbed windows each 
of which will be described in this chapter. 
 
Note: 
In this chapter, all options are available based on a duplex 
(double-side) scanner. If you have purchased a simplex 
(single-side) scanner, all options are available for single sided 
only. 
 

  
The Scanner Properties dialog box 
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4.1 Buttons on the Scanner Properties Dialog Box  

 
 

The buttons on the Scanner Properties dialog box 
 

Buttons Description 

Defaults Click the Defaults button, the factory default 
settings will be shown on each tab.   

Scan After all the scan settings are satisfactory, click 
the Scan button to start scanning your 
document. 

Close Click the Close button to leave the Scanner 
Properties dialog box. 
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The following table shows the default settings： 
 
Tab name Default settings 
Image Image：Front B&W 

Binarization：Dynamic Threshold 
Resolution：200 dpi 
Invert：Blank on White 
Scan Source：Auto Document Feeder 
Threshold：None 
Brightness：None 
Contrast：None 

Compression None 
Color Dropout None 
Paper Cropping：Automatic 

Deskew：Yes 
Orientation：Portrait 
OverScan：0.00  
Unit：Inch 

Multi-Feed 
Detection 

None 

Preview None 
Options Rotation Degrees：None 

Blank Page Removal：None 
Edge Fill：White，0 mm 
Image Control Option：None 

Setting Enable Energy Saver：Enable, 15 
minutes after last scan action 
Show Scanning Progress：Yes 
Show Warning Message：Yes 
Save Settings after Closing：Yes 

Imprinter Digital Imprinter 
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4.2 The Image Tab  

The Image tab allows you to choose the front side and (or) 
the rear side of your document, the type of image, and to set 
several basic scan settings.  Note that except for the 
resolution, you can set individual scan settings for the front 
side and the rear side.  For example, all settings in the Image 
tab, Compression tab, Color Dropout tab can be set 
individually for the front and the rear side.  However, the 
settings in the Paper tab, the Option tab, and the Setting tab 
have to be set the same for the front and rear side.   
 

 
 

The Image tab dialog box 
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4.2.1 The Image Selection Box 

 

The Image Selection box includes 
the image type and document side 
option.  If you wish to scan both 
the front side and the rear side of 
your color document, you can 
check both Front Color and Rear 
Color at the same time.  Note the 
options vary based on type of 
scanner. 

 
Example 1：Scanning a two-sided color document, both 
sides in color 

 
 

Side/Image 
Selection 

 
Front  

Rear 
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Example 2：Scanning a two-sided color document, one 
in B&W(Drop Blue Color：Threshold：10, Background：
79), the other in color 

 

 

Side/Image 
Selection 

 

Front 

 

Rear 

 

Image Type Description 
Color Choose Color if you wish to scan a color 

image for your original in color.  
Gray Choose Gray image if your original contains 

actual shades of gray. 
B&W Choose B&W if your original contains only 

text, pencil or ink sketch. 

   
B&W Gray Color 
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Front/Rear Auto Color Detection:  

Click to automatically detect and scan the front or the rear 
page of your color document in color image mode.  If your 
document is in colors, the scanner will automatically scan the 
document into a color image.  If your document is non-color, 
you can choose the output to be either B&W or Gray from the 
Non-Color Selection option.  This option is useful when you 
have a mixture of color and non-color document. 

Note:  If you choose Front Rear Auto Color Detection, you can 
not specify the image mode of your rear page and vice versas. 

 
 

Sensitivity of Auto Color Detection 

If your documents contain primarily B&W text and small 
amount of light or pale colors and you do not wish them to be 
recognized as color image to save the file size, you can reduce 
the sensitivity value by moving the bar to the left to let these 
images to be detected as B&W. The value ranges from 1 to 
30.  The default is 20. 
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4.2.2 Other Image Options 

Binarization This is the process of converting a 
grayscale or color image to a bi-tonal 
image. There are several different 
methods of performing this conversion.  
Options:  Dynamic Threshold, Fixed 
Processing, Halftone 1~5, Error 
Diffusion. 

Dynamic Threshold:  Selecting 
Dynamic Threshold allows the scanner 
to dynamically evaluate each document 
to determine the optimal threshold value 
to produce the highest quality image.  
This is used to scan mixed document 
containing faint text, shaded background, 
or color background with a single setting.  
If Dynamic Threshold is selected, 
Threshold, Brightness, and Contrast are 
not available. 
 
Sensitivity of Dynamic Threshold 
 
Occasionally your scanned image may 
contain small dots or speckles. To remove 
these spots, increase the sensitivity value 
by moving the bar to the right. The value 
ranges from 1 to 30.  The default is 20. 
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 Fixed Processing:  Used for black-and-

white and other high contrast documents.  A 
single level is set to determine the black-
and-white transition. The threshold is 
programmable over the entire density 
range.  Fixed Processing sets Contrast to 
0.  If Fixed Processing is selected, 
Contrast is not available. 

 
 Halftone:  In addition to the black and 

white display, Halftone can present a 
somehow gray shade of image by using 
different size of dots.  Halftone image looks 
like the picture we have seen in the 
newspaper.  Options include Halftone 1, 
Halftone 2, Halftone 3, Halftone 4, 
Halftone 5.  
 
Error Diffusion:  Error Diffusion is a type 
of Halftone.  Error Diffusion gives good 
image texture and makes text in images 
more readable than Halftone. 
 

 
Halftone Image 
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Error Diffusion Image 
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Threshold Used to convert a grayscale image to a  

bi-tonal image. The value ranges from 0 to 
255. A low threshold value produces a 
lighter image, and can be used to subdue 
backgrounds and subtle, unneeded 
information. A high threshold value produces 
a darker image, and can be used to help pick 
up faint images.  
Adjust the threshold setting by dragging the 
Threshold sliding bar to the left or right to 
achieve the desired threshold setting. 
 

 
 
200 dpi, 
Threshold:50, 
Brightness: 0 

 
 
200 dpi,  
Threshold:100, 
Brightness: 0  
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Gray  
Document Type:  Choice:  Normal, Photo, Document   
Three options of document type are provided when you 
choose Gray as the image type for your scanned document.  
Choice:  Normal, Photo, Document.  

 Document: Choose Document if your original contains 
pure text or a mixture of text and graphic since it is an 
optimal setting for regular business document.  When 
using Document, only Threshold can be adjusted.   

 Photo: Choose Photo if your original contains photo to 
reproduce your photo in vivid grayscale image.  When 
using Photo, no Threshold and Contrast can be adjusted. 

 Normal: When using Normal, Threshold, Brightness, 
and Contrast can be adjusted.  

 
Threshold:  The value ranges from 0 to 255.  The default is 
230.  A low threshold value produces a lighter image, and can 
be used to subdue backgrounds and subtle, unneeded 
information. A high threshold value produces a darker image, 
and can be used to help pick up faint images. Adjust the 
threshold setting by dragging the Threshold sliding bar to the 
left or right to achieve the desired threshold setting. 
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Normal 

 
Photo 

 
Document 
(Threshold: 230) 
 

 
Normal 

 
Photo 

 
Document 
(Threshold: 230) 
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Brightness Adjusts the lightness or darkness of an 
image.  The higher the value, the brighter 
the image.  Drag the slider to the right or 
left to increase or decrease the brightness.  
The range is from –100 to +100. 

Contrast Adjusts the range between the darkest and 
the lightest shades in the image.  The 
higher the contrast, the bigger the different 
grayscale. Drag the slider to the right or 
left to increase or decrease the contrast.  
The range is from –100 to +100. 
 

   

Brightness: -50 Brightness: 0 
(Normal) 

Brightness: +50 

   
Contrast: -50 Contrast: 0 

(Normal) 
Contrast: +50 
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Resolution A good control of the resolution results a 

good detail of an image that scans.  The 
resolution is measured by dots per inch 
(dpi).  Normally, the greater the dpi number, 
the higher the resolution and the image file 
size.  Be aware that greater resolution takes 
more time to scan, and more disk space for 
the scanning image.  For your information, 
an A4 size color image scanned at 300 dpi at 
True Color mode consumes approximately 25 
MB of disk space. A higher resolution 
(usually means over 600 dpi) is only 
recommended when you need to scan a 
small area at True Color mode.  

Choose a resolution value from the drop 
down list. The default value is 200 dpi. 
Available resolutions are 75, 100, 150, 
200,300, 400 and 600. Or you may choose 
your desired value by clicking the box in the 
right side of the drop down list and press the 
arrow key to select your desired value and 
then click the Add button to include it in the 
drop down list. Note:  The resolution is up to 
300 dpi if an imprinter or a MICR reader is 
installed or connected to the scanner. 

 
Resolution: 75 dpi 

 
Resolution: 150 dpi 
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Invert Reverses the brightness and the colors in the 

image.  The default setting is Black on a White 
background.  Reverse mode is White on a Black 
background. For color images, each pixel will be 
changed into its complementary color at the 
command of Invert. 
 

 
Black on White 

 

 

White on Black  
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Scan 
Source 

Choice: 
 Auto Document Feeder:  Used to scan 

multiple pages. 
 Flatbed:  Used to scan a single page. For 

example, pages from newspaper clipping, 
paper with wrinkles or curls.  

 Flatbed (book):  Used to scan several 
inside pages from book. 

 Automatic:  Allow the scanner automatically 
set its scan source.  If Automatic is selected 
and there is document in both the auto 
document feeder (ADF) and the flatbed, then 
the scan source will be automatically set to 
ADF.  If Automatic is selected and there is 
document only in flatbed, then the scan 
source will be set to flatbed. 

 Merge Two Sides into One Image:  
If you have a sheet-fed duplex scanner with 
front input tray, you can scan an A3 size 
document with an innovative method.  Thus, 
fold your A3 size document into A4, and then 
load the paper in the front tray.  Choose 
Merge Two Sides from the Scan Source 
option and then the scanner is able to scan 
both sides of your document and merge two 
A4 images into one A3 image.  

 
When you select Merge Two Sides into One 
Image, the Cropping or Multi-feed function 
will be disabled. 

 
Note the options vary based on type of 
scanner. 
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Select the “Merge Vertically” option to merge 
the front side and the rear side of a page into 
one image vertically. If the “Merge Vertically” 
option has not been selected, the front side 
and the rear side of a page will be merged into 
one page horizontally. 

 

Front 
Side 

Rear 
Side 

Merge Vertically 

Front 

Merge Horizontally 

Rear 
Side Side 

 
 
 
 
 
 
 
 
 
 
 
 

Note the options vary based on type of 
scanner. 
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Color 
Matching 

 

The purpose of Color Matching is getting the 
accurate color. This option uses the default 
parameters (ICC profile) to adjust the colors 
of the image.  

Choice: None, Document, Photo 
 None: Choose “None” to disable this 

option. 
 Document: Choose “Document” if your 

original contains pure text or a mixture of 
text and graphic since it is an optimal 
setting for regular business document.     

 Photo: Choose “Photo” if your original 
contains photo to reproduce your photo 
in vivid color image.  

 

            
                        Normal 
 

           
                 After Color Matching 
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4.2.3 Scanning color images 

The following options are available for scanning color images.  

 Brightness 
 Contrast 
 Resolution 
 Invert 

 

4.2.4 Scanning grayscale images  

The following options are available for scanning gray images.  

 Brightness 
 Contrast 
 Resolution 
 Invert 

  

4.2.5 Scanning B&W images  

The following options are available for scanning B&W images.  

 Binarization (Dynamic Threshold) 
 Resolution 
 Invert 
 

Or 
 Binarization (Fix Processing) 
 Threshold 
 Brightness 
 Resolution 
 Invert 
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4.2.6 Editing Profiles 

 
The Scanner Properties dialog box allows you to change and 
save your frequently used scan settings into a profile.  You 
can edit these profiles by renaming or deleting them.  
 
To add a new profile, 
 
1. Customize your settings.  (For example, change your 

resolution, image type, cropping method, scan size, or 
other scan settings.)  

2. Click the Image tab and then choose “Profiles” to prompt 
the “Edit Your Profile” dialog box.  

 
 
3. Click “Add” to enter the name of the profile and then 

choose “Save”. 

 
 
4. The new profile will be saved and shown in the “Profiles” 

dropdown list box.  
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To load a profile,  
 
1. From the Image tab dialog box, choose your favorable 

profile from the “Profiles” dropdown list box. 

 

2. Your favorable profile will be immediately loaded and 
displayed on Scanner Properties dialog box. 

 
 
To delete a profile, 
 
1. From the Image tab dialog box, click “Profiles” to prompt 

the Edit Your Profile dialog box. 

 
 
2. Choose the profile you want to delete from the dropdown 

list box. 
3. Click “Delete”.  A Confirm message “Are you sure you 

want to delete this profile?” is prompted. 
4. Choose “Yes” to delete or “Cancel” to quit. 
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To rename a profile, 
 
1. From the Image tab dialog box, click “Profiles” to prompt 

the Edit Your Profile dialog box. 

 
 
2. Choose the profile you want to rename from the 

dropdown list box and then click the Rename button. 
 
3. Enter new name for the profile. 

 
 
4. Choose “Save” to save the new profile or “Cancel” to quit. 
 
Note: 
The preset default profiles include Flatbed, Simplex-B&W, 200 
dpi, Simplex-Gray, 200 dpi, Simplex-Color, 200 dpi, Duplex-
B&W, 200 dpi, Duplex-Gray, 200 dpi, Duplex-Color, 200 dpi.  
If you have a simplex or a sheetfed scanner, the duplex or the 
flatbed option will not be available. 
 

 4-23 



 User’s Manual 

 

4.3 The Compression Tab 

The Compression tab allows you to compress your scanned 
image and choose the level of compression.  Bi-tonal images 
are normally compressed using CCITT standard called Group 4 
(G4).  Color and grayscale images are often compressed using 
JPEG technology.  Move the JPEG Quality slider to the right 
or left to increase or decrease the level of compression.  Note 
the greater the compression level, the lower image quality.  
Default is 50%. 

 
Note that the compression depends on your image editing 
application.  If your image editing application does not support 
the type of compression format, then  either a warning 
message will appear or the image quality of the compressed 
file will not be acceptable.  
 
JPEG (Joint Photographic Editor Group).  This group developed 
and lent their name to a file compression standard for color 
and grayscale images that is widely used by scanners, and 
software applications.  On Microsoft Windows-based systems, 
a file with the extension .jpg has normally been compressed 
using this standard. 

 
For scanning color or gray images, the following compressions 
are available: 

 None 
 JPEG 

 
For scanning B&W images, the following compressions are 
available: 

 None  
 G4 
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The Compression tab dialog box 
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4.4 The Color Dropout Tab   

4.4.1 Color Dropout Selection 

Color Dropout tab allows you to drop either of the red, blue, 
or green color in your scanned image.  If your image contains 
red color watermark or background, choose the R (Red) 
channel then any red watermark or background will be 
removed.  This feature is used to sharpen your text when 
using OCR (Optical Character Recognition) software.   

The “Custom” option allows you to specify your desired color 
to be removed by entering its RGB (Red, Green, and Blue) 
value respectively.  
 
Tolerance: Specify the allowable color range to be removed 
for the color you selected. Specified range: 1 ~ 100  
The large the numeric value, the wider the color dropout 
range is.  
 
Note that this function supports only black & white and gray 
images.  Therefore, be sure to choose any black & white or 
gray image type while applying this function. 
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The Color Dropout dialog box 
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4.4.2 Other Color Dropout Options 

 
Advanced Processing provides two options that can adjust 
your scanned image in the best optimal result. 
 
Filter 
Threshold 

This value is used to determine the color 
which will be dropped out.  A lower value will 
drop more of the selected color out, while a 
higher value will leave more of the selected 
color in. 

Background 
Level 

The pixel which is higher than the 
background value will be adjusted to the 
lightest point.  Adjust the value for both the 
Filter Threshold and Background Level to 
produce the best optimal result. 
 

Example, slightly adjusting the background value makes 
your text more clear.  
 

 
Original 
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Remove Blue, Threshold: 20, Background: 
255 

 
Remove Blue, Threshold: 20,  
Background Level: 210 
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4.5 The Paper Tab  

The Paper tab allows you to define values relating to image 
output (i.e., Auto Crop or not, Scan Area, OverScan, Multi-
Feed Detection).  
 

 

The Paper tab dialog box 
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4.5.1 Cropping  

Cropping allows you to capture a portion of the document 
being scanned.  Choice:  Automatic, Fixed to 
Transport, EOP (End of Page) Detection, Automatic 
Multiple, Relative to Documents. 

 
Options Description 

Automatic Automatic adjusts the cropping window 
according to different document sizes. Use 
this option for batches of mixed-sized 
documents. 

Fixed to 
Transport 

This feature allows you to define the area 
or zone to be imaged.  Use for batches of 
same-sized documents.  If you select this 
option, you can use the arrow keys to 
define the x and y offset values, width and 
length to redefine your scanned area.  The 
Display window will show image placement 
as you change the values. 

EOP (End of 
Page) 
Detection 

This feature allows you to define the area 
or zone to be imaged.  Use for batches of 
same-width but different length 
documents.  If you select this option, you 
can use the arrow keys to define the x and 
y offset values, width and length to 
redefine your scanned area.  The Display 
window will show image placement as you 
change the values. 
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Automatic 
Multiple 

This option allows you to place various 
sized documents such as photos, ID Cards, 
or business cards on the flatbed (if 
available) and lets you create multiple 
individually cropped images in one scan. 
Note: To correctly create multiple images, 
please make sure there is at least 12mm 
(0.5”) of space between each document. 

Relative to 
Document 

This option allows you to crop different 
areas on your documents and deliver these 
images in B&W, Gray, or Color separately.  
For example, there are applications which 
require you to store the entire document in 
B&W and a part of the document in color to 
save storage space.  This is useful for 
documents where a photograph or 
signature appears in a consistent area on 
the document such as resumes, and so on. 

 

The following options are only available when Fixed to 
Transport is selected.  

 X-Offset — the distance from the left end of the 
scanner to the left edge of the scanning area.  

 Y-Offset — the position from the top end of the 
document to the top end of the scanning area.  

 Width — the width of the scanning area.  

 Length — the length of the scanning area.  

 Center: automatically calculates the x-offset for center-
fed feeding based upon document size selected. 

 — relocate the scan area by click the arrow key on 
the cross sign while retain the scan size.  View the result 
from the Display window.   
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Relative to Document: (used for batches of same-sized 
documents) 

This option allows you to crop different areas on your 
documents and deliver these images in B&W, Gray, or Color 
separately.  For example, there are applications which require 
you to store the entire document in B&W and a part of the 
document in color to save storage space.  This is useful for 
documents where a photograph or signature appears in a 
consistent area on the document such as resumes, and so on.   
 
The following procedure describes how to reproduce the entire 
document in B&W and a portion of document (picture) in 
color.   
 
1. On the Paper tab, choose “Relative to Document” or 

“Fixed to Transport” from the Cropping option. 

2. Choose your scan size from the Scan Area option.  The 
selected scan size will be displayed in a red rectangular 
box.  This is also the scan size of your entire document. 
(For example, ISO B5.  If you have not chosen a scan 
area and leave the selection as None, then the default 
area will be the scanner’s maximum.)  

 

1 

2 A red 
rectangular 
box 
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3. Click the Preview tab to display the Preview window.  A 

black rectangular box appears to indicate the max. scan 
size your have just selected. 

 
 
4. Click the Preview button to view the entire image in low 

resolution to correctly crop your relative scan area.  

 

A black 
rectangular 
box 

The selected 
image  

The Preview 
Image 

The Preview 
Button 

The Image 
Selection 

Box 

5. Select image type from the Image Selection box.  The 
selected image will appear in highlighted color. (For 
example, Front Color) 

6. Place your cursor on the Preview window and click your 
left mouse button.  A cross sign will appear as illustrated.  
Create your relative scan size diagonally by dragging the 
left mouse button to your preferable size.  The selected 
area will appear in a red box as illustrated.  
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A Cross 
Sign 

 

The 
Relative 
Area  

7. Check the B&W image from the Image Selection box to 
scan the entire document. 

8. Click the Scan button to start scanning the document in 
two image types and sizes.  (See the result in below.)  

   
   The entire document in B&W     The relative area in color 
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4.5.2 Other Paper Selection 

Deskew 

Use this option to automatically deskew a document.   

  

Note: If the skew angle is 
too great, some of the 
image may be cut off. 

 
 
Scan Area  

Choose your desired paper size with the drop-down list box.  
Or you may select a custom paper size by clicking the Scan 
Area box and then click Add to include in the choice. 

Choice:  None, US Letter- 8.5”x 11”, US Legal – 8.5” x 14”, 
ISO A4 – 21 x 29.7 cm, ISO A5 – 14.8 x 21 cm, ISO A6 – 
10.5 x 14.8cm, ISO A7 – 7.4 x 10/5 cm, ISO B5 – 17.6 x 25 
cm, ISO B6 – 12.5 x 17.6 cm, ISO B7 – 8.8 x 12.5 cm, JIS 
B5 – 18.2 x 25.7 cm, JIS B6 – 12.8 x 18.2 cm, JIS B7 – 9.1 x 
12.8 cm, Scanner Maximum, Long Page. 

 
Long Page:   
When you need to scan documents whose length exceeds 
scanner maximum, please choose Long Page.  Note if Long 
Page is selected, the Multi-Feed Detection will not be 
available. Options: Unknown Length, Enter Length   (Note: 
This option varies due to type of scanner.)   
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Choose “Unknown Length” if you have a batch of long page 
document with unknown length. Choose “Enter Length” to 
enter the length and width of your documents or your desired 
scan size on documents.  This is useful when you have a batch 
of documents with the same scan size or a batch of same-
sized documents. 

OverScan 
Overscan allows you to add a specific margin at top and 
bottom or right and left (Options vary based on the type of 
scanner) of the edge of the image.  This is used to reduce 
possible corner clipping on the skewed images and often 
applied to a batch of skewed document to be scanned in the 
auto document feeder.  Select a value between 0 and +5 mm.   
Note the overscan result will not be shown in the Display 
window and that the availability of the function varies based 
on type of scanner.  
 
 
Pre-Feed 
Choice:  Enable, Disable.  If enable is selected, you can set 
the amount of time the scanner starts pre-feeding your paper 
after your documents has been loaded into the feeder. The 
default is disable. 
 
Transport Timeout 
Set the amount of time the scanner will wait and then start 
auto scan after the first scan job is completed. If you have 
many separate documents need to be scanned at the same 
scan settings, this feature is especially useful. The default is 0.  
The value ranges from 0 to 30 seconds. 
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Note:  
1 Within the specified timeout period, if you load your 

document to the feeder, the scanner starts scanning 
automatically. 

2 If your scanner has a flatbed option and you place your 
paper on the flatbed, after the timeout period, you need 
to click the Scan button on the TWAIN user interface to 
start scanning.  
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4.6 The Multi-Feed Detection Tab 

Multi-Feed Detection    

Multi-Feed Detection allows you to detect overlapped 
document that go through the auto document feeder. Multi-
Feed usually occurs due to stapled documents, adhesives on 
documents, or electro-statically charged document. Note： 
The availability of the function varies based on type of scanner. 
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Additional Length Detection 
Additional Length Detection allows you to define the length of 
document being multi-fed.  This value indicates the additional 
length exceeding your scan area.  The Display window will 
show the size of the document as you change the value.  A 
value of 0 indicates no additional length detection.  The 
Additional Length Detection is best used when scanning same-
size documents in the auto document feeder.   
 
Intelligent Mode (Skip Multi-Feed) By Ultrasonic 
Detection 
Some documents which are glued with a photo or a label may 
easily be detected as multi-feed yet you wish to bypass these 
multi-feed conditions. In this case, you can use the intelligent 
mode to let the scanner memorizes and skips these multi-feed 
conditions. Choice includes Disable, By 
Length(Paper/Object), By Position, By 
Length(Paper/Object)+Position.   
 
By Length (Paper/Object): When a multi-feed is detected 
for the first time, the scanner memorizes both the length of 
the document and the length of the object (photo or label) 
attached to the document. When you perform next scanning, 
this pattern of multi-feed will be bypassed. 

 

By Position: When a multi-feed is detected for the first time, 
the scanner memorizes the position of the photo or label 
attached to the document. When you perform next scanning, 
this pattern of multi-feed will be bypassed. 
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By Length (Paper/Object)+Position: When a multi-feed is 
detected for the first time, the scanner memorizes the length 
of the document, the length and position of the object (photo 
or label) attached to the document. When you perform next 
scanning, this pattern of multi-feed will be bypassed. 

To use the intelligent mode, 

1. Choose your desired multi-feed detecting method to 
bypass by.  

2. When multi-feed occurs during scanning, a multi-feed 
warning message appears. 

3. Choose OK to skip the multi-feed condition from next 
scanning and close the message.  

4. Open your TWAIN data source in your scanning 
application. The same multi-feed condition will not be 
recognized as multi-feed. 

 
 
Note:  
1. You can clear the previous multi-feed conditions by 

clicking the Reset button. 
2. The scanner can memorize to bypass up to 25 multi-feed 

conditions. 
3. If you uninstall your scanner driver, the previous multi-

feed conditions which have been set to memorize and 
skip will still be valid. 
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Detection Area 

This option allows you to specify a multi-feed detection area. 

To specify a multi-feed detection area, 

1. Choose Disable from the Intelligent Mode. The Detection 
Area will be enabled. 

2. Choose Inside the Range or Outside the Range. The 
detection area will be highlighted. 

3. Drag your mouse pointer on the top or the bottom of the 
detection area to specify your area in the display window. 
Or you may use the up and down arrow key of the Top 
and Bottom to change its size. The Top indicates the 
starting position of the detection range. The Bottom 
indicates the ending position of the detection range. Note 
the top value and the detection range has to be at least 1 
inch. 

 

Detection Area: Inside the Range, Box, Top: 3”, Bottom: 7” 
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Detection Area: Outside the Range, Box, Top: 3”, Bottom: 7” 
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Ultrasonic Detection 
 
Ultrasonic Detection  allows you to set overlapped document 
by detecting paper thickness between documents.  Note： The 
availability of the function varies based on type of scanner. 
 
 
There are two options available if Multi-Feed is detected.  

 Stop Scanning after Multi-Feed 

If this is selected, the scanner will stop the feeder and 
display the following Warning dialog box if multi-feed is 
detected. 

 

 

Action:   

1. Follow the instruction on the Warning dialog box to 
remove the rest pages on the feeder. 

2. Click OK to close the Warning dialog box. 

3. Scan the rest pages. 
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Clear the Multi-Fed Paper:  Auto 
 
If this is checked, once multi-feed is detected and scanning 
operation is stopped, the scanner will automatically clear the 
transport of the multi-fed paper.  If this is not checked, once 
multi-feed is detected and scanning operation is stopped, you 
need to manually clear the transport of the multi-fed paper.  
Note:  The availability of this option varies based on type of 
scanner. 
 
 
 Multi-Feed Alarm  

If a wave file is added, the scanner will make a sound 
alarm if multi-feed is detected yet no Warning dialog box 
will be displayed.   

If “Stop Scanning after Multi-Feed” is selected, the 
scanner will stop the feeder.   

If “Stop Scanning after Multi-Feed” has not been selected, 
the scanner will continue to scan till the end of your 
document. 

Action: 

1. If “Stop Scanning after Multi-Feed” is selected, follow 
the action described in the preceding section “Stop 
Scanning after Multi-Feed” on the previous page to 
complete your job. 

2. If “Stop Scanning after Multi-Feed” has not been 
selected, rescan the pages where multi-feed is 
detected. 
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How to add the sound alarm： 

1.  Click the Browse button on the right side of the speaker 
icon. The Open dialog box appears.  

2.  Choose your wave file.  

3.  Click the Open button.  The wave file is added.  
 

Units 

Defines the primary measurement system.  Inches, 

Millimeters, and Pixels are available.  
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4.7 The Preview Tab 

The Preview tab allows you to preview (a low-resolution scan) 
your image before final scan.  This preview image lets you 
allocate your scan area.  You can choose your scan area by 
the “Scan Area” drop down list box or placing your cursor on 
the Display window and dragging it diagonally on the Display 
window.  Then, a red rectangle box will appear to indicate the 
selected area. 
 
Note:  If you choose “Automatic Cropping” on the “Paper 
Tab”, then to select a scan area on the Preview tab is not 
allowed. 
 

 

The Display 
Window 

 
The Preview Tab 
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4.8 The Options Tab 

The Options tab allows you to set following additional image 
processing settings.   
 

 

The Option tab dialog box 
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Flip Side 
Rotation 

Select “fanfold” to rotate the image 
of the reverse side to 180 degrees.   

This is applied to double-sided 
document which are viewed in 
portrait are sometime fed into the 
scanner in landscape or vice versa.   

Choice: Book, Fanfold. 

If “Book” is selected, the image of 
the reverse side will not be rotated.  

 
The following illustration shows the documents which should 
be viewed in portrait are fed into the scanner in landscape 
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Rotate Image Choose the rotation angle from the drop 
down list if you wish to rotate your 
scanned image. 

Choice: None, 90°CW(clockwise), 
90°CCW(counter clockwise), 180°, 
Auto based on contents. Auto 
rotate every even page. 

 

Original 
 

Rotate 90°CW 

 
Rotate 90°CCW 

 

Rotate 180° 
 

 Auto based on contents:  When Auto 
based on contents is selected, images 
can be rotated to their proper 
orientations based on their contents. 

Auto rotate every even page: 
Automatically rotate 180° on every 
even page.  This is especially useful 
when you scan the inside pages from a 
book.  As a result, if you choose 
“Flatbed (book)” from the “Scan 
Source” option, “auto rotate every even 
page” will be selected as default.   
 
Note:  This option varies based on 
type of scanner. 
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Blank Page 
Removal 

Check if you wish to remove the blank page 
and move the slider to the left or right to your 
desired threshold.   

 

Edge 
Fill 

 

Check White or Black if you wish to add white or 
black edge on the border of your scanned image. 
Enter the value from 0 to 5 mm.  Default value is 0. 

 
Original 

 
Edge Fill: 5mm (Black) 
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Image 
Control 
Option 

Check the Mirror box if you wish to reverse the right 
and left side of your image. 

 

 
Original 

 

 

 
The Mirror Effect 
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Punch 
Hole 
Removal 

You can remove punch holes from the output 
scanned image when scanning punched document. 
Note the availability of this feature varies 
depending on your scanner model. 
 
 
 
 
 
 
 
 
 
 
 
 
Punch holes can not be removed when: 
 Resolution is set lower than 150dpi 
 The hole is near the edge of the document 
 The holes are not aligned along the edge of the 

document 
 Punch Hole Removal is available only when 

“Auto Crop” is enabled. If either “Fixed to 
Transport”, “EOP (End of Page) Detection”, 
“Automatic Multiple”, “Relative to Documents” is 
selected from the Cropping option on the Paper 
tab, the Punch Hole Removal option will be 
disabled. 

 

Original Output image 
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Despeckle 
 
Occasionally small dots or specks appear in the background of 
a scanned image. Remove unwanted speckles provides a 
cleaner image for OCR (Optical Character Recognition) 
processing, and also helps to reduce compressed file size. 
 
Define the speckles (also known as image noise) you wish to 
remove by specifying its number (size) and radius (range). 
The measuring unit is pixel. The higher the number, the more 
speckles will be removed.  
 

 
Before Despeckle  
(noise number:0, noise radius:1) 

 
 

 
After Despeckle  
(noise number:22, noise radius:10) 
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Note:  
 The function is currently available for Black and White 

image only. 
 To scan at rated speed, it is recommended to set the 

noise radius up to 10 pixels. 
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Backgroun
d Setting 

This option allows you to set your scan 
background. Choice: White Background, 
Black Background. 

Note: For a sheet-fed scanner with an auto 
document feeder, this option is currently 
available only in the “Auto crop” mode. For a 
scanner with a flatbed platen, this option is 
available either in the “Auto crop” or the 
“Fixed to Transport” mode.  
 
For details on choosing the “Auto crop” or 
the “Fixed to Transport” mode, please refer 
to section 4.5.1, Cropping. 

 
White Background 

 

 
Black Background 
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4.9 The Setting Tab 

The Setting tab allows you to set the following settings: 

 

The Setting tab dialog box 
 
Energy Saving 
Control 

Check the Enable Energy Saver box 
and move the slider to set the amount 
of time to start the energy saver after 
your last action. The range is from 1 to 
240 minutes.  The default value is 15 
minutes. 

Enable Power 
Off   

Check the Enable Power Off box and 
move the slider to set the amount of 
time to automatically turn off the 
scanner after your last action. The 
range is from 1 to 480 minutes.  The 
default is 240 minutes (4 hours). Note 
the value of “Power Off” has to be 
greater than or equal to the value of 
“Energy Saving”. 
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Cache 
 

Mode: None, Page Number, Memory 
Size.  
This option allows you to assign a specified 
memory size from the available RAM to 
process the image data. By specifying a 
smaller memory size, you can free more 
memory for other applications you are 
running. By specifying a larger memory 
size, you can have more memory to 
process the image data especially when you 
have a large amount of documents needed 
to be scanned.  
 
You can also specify your memory size by 
the page number. For your information, an 
A4 color document scanning at 300 dpi 
consumes approximates 24MB. 

Image Count 
When the selected cache mode is “none”, 
the image count option allows you to assign 
number of pages you need to scan. For 
example, if you wish to scan the first two 
pages, simply move the page slider to 2, 
and the scan action will be stopped when 
the scanning of the first two pages have 
been completed. 

Barcode 
Detection 

Check this option to enable detecting and 
recognizing barcode in your document. 
After the detecting process, an 
avbarcode.ini file will be generated and 
stored in your system drive, for example, 
Windows\avbarcode.ini.  
Note:  The availability of this feature varies 
based on type of scanner. 
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Show Scanning 
Progress 

Check and the scanning progress bar 
will be shown during scanning. 

Show Warning 
Message 

Check to show the warning messages 
such as “ADF pad count exceeds 
50,000 scans (the number varies based 
on type of scanner). Please replace the 
ADF pad and reset the pad count.” 

Save Settings 
after Closing 

Check to save your scanner properties 
settings after leaving the dialog box.  
Next time when you open the Scanner 
Properties dialog box, the previously 
saved settings will be shown. 
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4.10 The Imprinter Tab 

The Imprinter tab allows you to print alphanumeric characters, 
date, time, document count and custom message on your 
scanned image if digital imprinter is selected or at the back of 
your document if external imprinter is selected.  
 

 
 
 
Choice:  External Imprinter, Digital Imprinter. If you 
have installed an external imprinter, choose external 
imprinter. If you do not have an imprinter, choose digital 
imprinter. Note External Imprinter provides a vertical and 
rear-side print capability while digital printer provides a 
horizontal and front-side print capability. 
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Contents 

Print All Check Print All to automatically print the 
text at all pages of your documents.  
Uncheck Print All to print the text for the 
first page of your documents only. 

Custom Enter your custom text to be included in your 
print string.  

Counter Show the document count for the scan 
session. This value is increased sequentially 
by the scanner.    

 
Date/Time Choose if you wish to include the date and 

time in your print string. 
Format: YYYYMMDDHHSS For example, 
20090402170645-check0001 indicates year, 
month, date, hour, seconds, your custom 
text and the counter. 

Custom 
Font 

Choose your desired font.  
Choice: Normal, Fixed Width 
Fixed Width (Mono spaced) fonts have a 
fixed character spacing. So each character 
occupies the same width. 

 

Advanced 

Font 
Attributes 

Choose your font attributes.  Choice:  
Normal, Underline, Double, and Bold. 
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String 
Orientation 

Choose your string orientation. 
Choice: Normal, Rotated, Vertical, 
Vertical Inversion, 90 degrees CW, 90 
degrees CCW 

 
Normal 

 
Rotated 

 
Vertical 

 
Vertical Inversion 

 
90 degrees CW  

90 degrees CCW 
 
If you check the digital imprinter to stamp 
text on your scanned image, the illustration of 
normal and rotated string is shown below: 

 
Normal 

 
Rotated 
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Print 
Position 

Choose the position you wish to print your 
string. Move the slider to the right to increase 
the value or to the left to decrease the value. 
Range: 0~355mm, default:0 mm 
The value indicates the height from the 
bottom of your paper to the last letter of your 
string. This option is available only if an 
external imprinter is installed. 
 
 
 
 
 
 
 
 
 
 

0
0
0
1
ab

c 2
0
1
0
   

The value of 
Print Position 

 

Print Position (for digital imprinter) 
Choose the position of your printed string. Choice: Top, 
Middle, Bottom, Custom. If Custom is selected, enter the X 
and Y offset value to specify the position. 
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4.11 The Information Tab  

The Information tab displays the following system and scanner 
information.  

 
 

The Information tab dialog box 
 
 

The “Report” button： 

If you encounter any error message while using the scanner, 
click the Report button.  A report.txt file (C:\AVxxx) will be 
generated.  Please send this file to the nearest service center 
for trouble shooting.   
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The “Reset Pad Count” button： 

After scanning approximately 50,000 pages (the number 
varies based on type of scanner) through the Auto Document 
Feeder (ADF), the ADF pad may be worn out and you may 
experience problems with document feeding.  In this case, it is 
highly recommended to replace the ADF pad with a new one. 
(Please refer to the manual for proper replacing procedure.)  
For ordering the ADF pad, please consult your nearest dealer.  
After replacing the ADF pad, click the “Reset Pad Count” 
button to reset the pad count.  

 

The “Reset Roller Count” button： 

After scanning approximately 200,000 pages (the number 
varies based on type of scanner) through the ADF, the ADF 
roller may be worn out and you may experience problems with 
document feeding.  In this case, it is highly recommended to 
replace the ADF roller with a new one. (Note the replacement 
of the ADF roller has to be performed only by authorized 
service center.  Therefore, please return your scanner for 
roller replacement.)   After replacing the ADF roller, click the 
“Reset Roller Count” button to reset the roller count.   

Note： 
The lifetime and the replacing procedure vary based on type 
of scanner. 
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5. ISIS Interface Operation 

 
 
 
* Please refer to the preceding chapter, Scanner Installation, to 
install ISIS scanner driver. You may start the supplied 
QuickScan software application to scan via the ISIS user 
interface. 
 
The ISIS driver operation method is similar to the TWAIN’s. 
Every function on the ISIS interface screen is briefly described 
as below: 
 

 
 
Mode: Select one of scan modes, including B&W, gray, color 
options. 

Dither: 5 halftone levels available, can be disabled. 

Dots per inch: Select your desired resolution. 

Paper Size: Select your desired paper size. 
Brightness: Adjust your scan image brightness or darkness. 

Contrast: Adjust the range between the darkest and the 
lightest shades in the image. 

Default: Click to reset all settings. 
Area: Select your desired scan area or position. 
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6. Using the Buttons  

 

 

 
The convenient buttons on the scanner is shown as below: 
 

 
 

Figure 6-1 
 

 

 

Function Display 

Function Selector 

The Cancel/Stop Button 

The Scan Button 

The Power Button 
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6.1 Installing Button Manager V2 

Button Manager V2 provides you an easy way to scan your 
document and then link the scanned image to your designated 
software application.  All this can be done by a simple touch of 
the button on the scanner. Yet, before you scan, it is 
recommended to check the button configurations first to ensure 
a proper file format and a destination application.   
 

6.2 Checking the Button Configurations before Scanning  

1. Button Manager V2 runs from the system tray. After Button 
Manager V2 and the scanner driver are properly installed, 
Button Manager V2 is started and the Button icon will be 
displayed on the system tray at the bottom right corner of 
your computer screen. 
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2. Left-click the Button Manager V2 icon to prompt the 

following Button Panel.  
 
 
 This indicates the scanner model  

 

The Function 
Icon 
(The number of 
function icons 
vary based on 
type of 
scanner.) 

The Button 
Icon

The Button Panel 
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3. The Button Panel shows the first five scanning buttons.  

Right-click the button (function) you wish to check.  The 
Button Properties window appears. 

 
 

Name of the Selected Button 
 

 

Folder and 
file name 
for the 
scanned 
image 

Scan To 
destination 
and settings 

Image Mode 
Selection 
Box 

Button 
Name 

Basic Scan 
Parameters 

OCR 
settings 

 
 

If you wish to change the setting, use this window to reset 
the setting for the file format, destination application, or 
other scan settings.     
 

4. Click the OK button to leave the window.  
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6.3 Using Button Manager V2 with Default Function 

Numbers and Predefined Tasks 

The scanner is shipped with nine preconfigured button settings 
for your frequently tasks such as scan-to-folder, scan-to-email, 
or scan-to-printer.  The following table shows these factory 
default settings.  You can change any of these settings. 
 
Button 
Number 

Name Destination/ 
Application 

Preset Scan 
Settings 

1 iScan 
(Image) 

Select this 
button when you 
want to scan a 
document and 
insert a scanned 
image to your 
application 
which is already 
launched  

Auto Color Detection, 
200 dpi, Simplex, 
JPEG, Auto Crop 

2 iScan 
(OCR) 

Select this 
button when you 
want scan a 
document and 
to insert the 
editable text 
after 
OCR(Optical 
Character 
Recognition) to 
your text editor 
which is already 
opened.  

Auto Color Detection, 
300 dpi, Simplex, 
JPEG, Auto Crop 
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3 Scan To 
App 

Select this button 
when you want to 
scan a document 
and send the  
image to your 
designated 
application 
(default: MS Paint) 

Auto Color Detection, 
200 dpi, Simplex, 
JPEG, Auto Crop 

4 E-mail Select this button 
when you want to 
scan a document 
and send the 
image from your 
default e-mail 
software to an e-
mail recipient as 
an attachment. 

Auto Color Detection, 
200 dpi, Simplex, 
JPEG, Auto Crop 

5 Printer Select this button 
when you want to 
scan a document 
and print it from 
your default 
printer 

Auto Color Detection, 
200 dpi, Simplex, 
JPEG, Auto Crop 

6 Shared 
Folder 

Select this button 
when you want to 
scan a document 
and save the 
image to a shared 
folder in the 
network. 

Auto Color Detection, 
200 dpi, Simplex, 
JPEG, Auto Crop 
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7 FTP Select this button 

when you want to 
scan a document 
and save the 
image to a network 
file server such as 
FTP. 

Auto Color Detection, 
200 dpi, Simplex, 
JPEG, Auto Crop 

8 ShareP
oint 

Select this button 
when you want to 
scan a document 
and save the 
image to a network 
file server such as  
Microsoft 
SharePoint server. 

Auto Color Detection, 
200 dpi, Simplex, 
JPEG, Auto Crop 

9 Google 
Docs 

Select this button 
when you want to 
scan a document 
and save the 
image to a network 
file server such as 
Google Docs 

Auto Color Detection, 
200 dpi, Simplex, 
JPEG, Auto Crop 
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Note: 
 To accurately use the default settings, you need to setup 

your computer in an internet environment and install the 
necessary software applications such as E-mail software, or 
printer before installing Button Manager V2. 

 To send your scanned images to a network server such as 
FTP, Microsoft SharePoint, or Google Docs, make sure you 
have the previledge to access the network server. For 
example you need to create a login name and password 
first. 

 Microsoft .NET Framework: To accurately send your 
scanned images to a network server, Microsoft .NET 
Framework 2.0 or higher is required. (Check the program 
and the version by choosing Start>Control Panel>Add or 
Remove Programs. A list of programs will be displayed. If 
you have installed Microsoft .NET Framework, the program 
and the version will be shown in the list.).  

 Google Docs: Google provides a document hosting, 
management and editing service called Google Docs to 
every user that has signed up for an account at Google web 
site (http://docs.google.com).  

 Microsoft SharePoint: Microsoft SharePoint is a 
collaboration and document library tool developed by 
Microsoft for file sharing and web publishing. 
You may need to contact your system administrator to get 
the correct URL for the SharePoint server. Your system 
administrator will also give you access to the SharePoint and 
a valid user login and password. 
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6.4 Scanning From One Touch of the Buttons   

1. Adjust the paper guide for the width of paper and load the 
document with their tops into the automatic document 
feeder.   

2. Check the number on LCD screen on the scanner to ensure 
if you are selecting the proper scan settings and destination 
application. (For example, if you wish to scan with button 
#3 “Scan to App” which opens Microsoft Paint and displays 
the scanned image in the window of Microsoft Paint, the 
LCD screen should show #3).  

3. Press the Scan button on the scanner. 
4. After the scanning is finished, the Microsoft Paint software 

will be launched and the scanned image appears in the 
main window of Microsoft Paint as below.  

 

 
 
Note: 
1. For details information on how to use the Button Manager 

V2, please refer to the user’s manual in the supplied CD. 
2. You may also use Button Manager V2 on your desktop by 

starting Button Manager V2 from All Programs or double 
clicking the Avision Scanner Utility from the Control Panel. 
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7. Maintenance 

 
 
 

7.1 Cleaning the Glass 

The procedures  

1. Use a clean and lint-free cloth wet with isopropyl alcohol. 
(95%) 

2. Open the document cover as shown in Figure 7-1.  Wipe 
the document glass. 

3. Close the document cover.  Your scanner is now ready for 
use. 

 

 
 

Figure 7-1 The cleaning area 
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8. Using and Caring the 
Optional Auto Document 
Feeder 

 
 
 

8.1 Installing the Auto Document Feeder 

1. Remove the document cover. 
2. Insert two hinges of the auto document feeder to the 

corresponding holes on the document glass as shown in 
below. 

 

 
 

Figure 8-1 
 

 8-1 



 User’s Manual 

 
 

3. Pull out the paper chute extension to the length you want. 

4. Connect the ADF (Auto Document Feeder) cable (attached 

to the document cover) to the ADF port at the back of the 

product. 

 

 

Paper Chute Extension 

ADF Cable 
 

Figure 8-2 
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8.2 Loading Your Paper 

8.2.1 Notice on Using the ADF 

Before using the ADF, please make sure that your paper meets 
the following specifications: 

 Document(s) can range in size from 4.5” x 5.5” (114 x 
139 mm) to 8.5” x 14” (216 x 356 mm). 

 Document(s) can range in weight from 13 to 32 lbs 
(49~120 g/m2). 

 Document(s) should be square or rectangular and in good 
condition (not fragile or worn). 

 Document(s) should be free of curl, wrinkle, tears, wet 
ink, or punch holes. 

 Document(s) should be free of staples, paper clips, paper 
sticky notes. 
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8.2.2 Placing Your Document in the ADF Paper Tray 

1. Place your document(s) with the text FACE UP in the ADF 
and make sure that the top of each page feeds in first. 

2. Adjust the Paper Guides to center the document(s) in the 
ADF.  Make sure the paper touch the edge of the guides. 

 
 

Figure 8-3 
 

Paper Guide 
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8.3 Clearing a Paper Jam 

In the event of a paper jam, follow the procedures below to 
remove the paper: 

1. Gently open the Scanner Front Door to the left. 

2. Carefully pull the paper out of the ADF unit. 

3. Close the scanner front door.  Your Scanner is now ready 
to use. 

 
 

Figure 8-4 
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8.4 Caring the Auto Document Feeder 

8.4.1 Cleaning the Feeding Rollers 

From time to time the pad assembly and feeding rollers may 
become contaminated with ink, toner particles or paper dust.  
In this case the scanner may not feed documents smoothly.  
If this occurs please follow the cleaning procedures to return 
your machine to its original state. 
 

The Cleaning Procedures  

1. Dip a soft clean cloth with isopropyl alcohol (95%). 

2. Open the front door slightly to the left.  Wipe the feeding 
rollers.  Rotate the roller forward with your finger and 
repeat the cleaning steps above until the entire roller is 
cleaned.  

3. Wipe the rubber part of the ADF pad.  Be careful not to 
damage the pick springs. 

4. Close the scanner front door.  Your scanner is now ready 
for use. 

 
 

Figure 8-5 
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ADF Roller 

ADF Pad 
 

Figure 8-6 
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8.4.2 Replacing the ADF Snap-in Pad Module 

After scanning approximately 20,000 pages through the ADF, 
the pad may be worn out and you may experience problems 
with document feeding.  In this case, it is highly recommended 
to replace the pad module with a new one.  For ordering the 
pad module, please consult your nearest dealer and follow the 
procedure below to replace it.  

 

Disassembling Procedure 

1. Open the ADF front cover to the left.  

 
 

Figure 8-7 
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2. Press both sides of the ADF snap-in pad  module inwardly 

with your fingers to pull out the ADF snap-in pad from the 
slot.  

 

 

 

ADF Pad 
Module 

 
Figure 8-8 

 

Assembling Procedure 

1. Take out the ADF pad module from the box. 
2. Press both arms of the ADF snap-in pad module inwardly 

with your two fingers. 
3. Place it into the holes until it snaps into place.   
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8.4.3 Replacing the ADF Roller 

After scanning approximately 200,000 pages through the ADF, 
the ADF roller may be worn out and you may experience 
problems with document feeding.  In this case, you may need 
to replace a new ADF roller.  For ordering the ADF roller, please 
consult your nearest dealer and follow the procedure below to 
replace it.  

 

Disassembling Procedure 

1. Open the ADF front cover to the left. 

 
 

Figure 8-9 
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2. Press two wire legs inwardly to detach the wire legs from 

the slot. 

 
 

Figure 8-10 
 

3. Remove the ADF roller from the scanner. 

 
 

Figure 8-11 
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Assembling Procedure 

 
1. Insert the left end of the ADF roller to the left hole of the 

slot. Make sure the left end of the ADF roller is inserted 
and revealed as shown in below. 

 
 

Figure 8-12 

 
2. Insert two wire legs to the holes of the slot as shown in 

below. 
 

 
 

Figure 8-13 
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9. Troubleshooting 

 
 
 

9.1 Removing the abnormal lines on your scanned 
image 

If your scanned image is shown with abnormal lines on it, it is 
probably caused by the dust or toner particle on the strip of 
document glass.   

 
To remove the dust or toner particle,  

1. Dip a soft clean cloth with isopropyl alcohol (95%). 

2. Wipe the strip of document glass as shown below. 

3. Close the document cover.  The product is now ready for 

use. 
 

 
 

Figure 9-1 
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9.2 Questions and Answers 

Question:  When the scanner is powered on, it makes 
noises and won’t stand ready. 

Answer:  There are two possibilities: 

1) You might fail to push the scanner 
shipping lock to its “unlocked” position.  If 
this is the case, pull the scanner status 
switch to its “unlocked” position first. 

2) The scanner is not placed on an even, flat 
desktop surface.  This may cause the scanner 
to malfunction. 

 

Question:  The scanner is powered on, but the lamp 
does not light up. 

Answer:  The lamp is probably out of order.  Contact 
your local dealer or distributor to replace the 
lamp. For your information, the average life 
time of the lamp is about 15,000 hours and 
the operating temperature for the scanner is 
between 10°C(50°F) and 40°C(104°F). 

 

Question:  While scanning, the scanner often makes 
noises, or it scans back and forth. 

Answer:  Usually this means the memory of your 
computer is not enough or the speed of your 
CPU too slow.  Please try to increase your 
memory to at least 32M or replace your CPU 
with Pentium or later. 

 

 

 

 

 9-2 



 User’s Manual 

 

 

Question:  Why is it that the scanned image always 
comes out to be too dark? 

Answer:  1) Please adjust the screen settings to SRGB. 

2) Please adjust the brightness settings on 
the screen from application software. 

 

Question:  The scanner works well except for the line art 
image.  The lines in the image seem to be 
much thicker than the original one. 

Answer:  Increase the Brightness or adjust the 
Threshold setting to improve line art image. 

 

9.3 Technical Service  

Before contact Avision, please prepare the following 
information: 

 
 Scanner serial & revision number (located on the bottom of 

the scanner); 
 Hardware configuration (e.g., your host CPU type, RAM size, 

free disk space, display card, interface card); 
 The name and version of your scanning software application;  
 The version of your scanner driver.  
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Please call us at: 

 
Headquarter 
Avision Inc. 
No. 20, Creation Road I, Science-Based Industrial Park,  
Hsinchu 300, Taiwan, ROC 
TEL: +886 (3) 578-2388 
FAX: +886 (3) 577-7017 
E-MAIL:  service@avision.com.tw 
Web Site:  http://www.avision.com.tw 
 
US and Canada Area  
Avision Labs, Inc. 
6815 Mowry Ave., Newark CA 94560, USA 
TEL: +1 (510) 739-2369 
FAX: +1 (510) 739-6060 
E-MAIL:  support@avision-labs.com 
Web Site:  http://www.avision.com 
 
China Area  
Hongcai Technology Limited 
7A,No.1010,kaixuan Road,Shanghai 200052 P.R.C.  
TEL :+86-21-62816680 
FAX :+86-21-62818856 
E-MAIL :  sales@avision.net.cn 
Web Site:  http://www.avision.com.cn 

 
Europe Area  
Avision Europe GmbH  
Bischofstr. 101 D-47809 Krefeld Germany  
TEL: +49-2151-56981-40 
FAX: +49-2151-56981-42 
E-MAIL:  info@avision-europe.com 
Web Site:  http://www.avision.de 

 
 

 

mailto:service@avision.com.tw
mailto:support@avision-labs.com
http://www.avision.com.cn/
http://www.avision.de/
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10. Specifications 

 
 
 
All specifications are subject to change without notice. 
 

Model Number DF-1002S 

Scanner Type Flatbed / ADF (Optional) 

Scanning Mode Color/Grey/Black & White 

Optical Resolution  600 * 600 dpi 

Light Source LED 

Maximum Scanning Size 8.5” x 11.7” (216 x 297 mm) 

Interface High Speed USB 2.0 

Power Requirement 24Vdc，2.0A  

Power Consumption < 36 watts (operation) 

< 10 watts (standby) 

Humidity 10~85% RH 

Operation Temperature 10ºC ~ 35ºC 

Dimension (WxDxH) 18.9” x 11.3” x 4.5”  
(480 x 288 x 115 mm)  

Weight  6.5 kgs 

ADF Weight  2.12 kgs 
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Intelligent Mode (Skip 
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tion, 4-40 

Invert, 4-16 

Ｊ 
JPEG, 4-24 
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lock switch, 2-2 

Ｍ 
Mirror, 4-52 
Multi-Feed Detection, 4-39 

Ｎ 
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SharePoint, Google Docs, 
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Ｏ 
OverScan, 4-37 

Ｐ 
Print All, 4-61 
Print Position, 4-63 
Punch Hole Removal, 4-53 

Ｒ 
Reset Pad Count, 4-65 
Reset Roller Count, 4-65 
Resolution, 4-15 
Rotate Image, 4-50 

Ｓ 
Scan Area, 4-36 
String Orientation 

Normal, Rotated, Vertical, 
Vertical Inversion, 90 deg 
CW, 90 deg CCW, 4-62 

Ｔ 
Transport Timeout, 4-37 

Ｕ 
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